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Microsoft Office System

Q. What is the Microsoft Office System?

A. Microsoft Office has evolved from a suite of personal productivity products to a more comprehensive and integrated system. Building on the familiar tools that many people already know, the Microsoft Office System includes programs, servers, services, and solutions designed to work together to help address a broad array of business problems.
At the core of the Microsoft Office System are the Microsoft Office 2003 Editions—such as Microsoft Office 2003 Professional Edition 2003—which deliver the core desktop productivity tools. New features in these programs enhance how employees can work with one another, partners, and customers, and how organizations capture and use information. In addition to the core desktop editions, the Microsoft Office System includes new programs, servers, and services that build on the productivity software skills your employees already possess.
Used together, the Microsoft Office System can help you address business needs ranging from personal productivity management to complex project management.
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Q. Is the Microsoft Office System a single offering? Will there be a box that includes the whole Microsoft Office System?

A. No. The Microsoft Office System is a portfolio of products and services that provide the building blocks to build solutions to business needs. Those building blocks, many of which are familiar products such as Microsoft Office Professional Edition 2003, Microsoft Office Visio® 2003, and other programs, will continue to be available separately, along with some new additions such as Microsoft Office InfoPath™ 2003 and Microsoft Office OneNote™ 2003.

Find retail pricing and upgrade information for Microsoft Office System programs, servers, and services at http://www.microsoft.com/office. 
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Q. In addition to the Microsoft Office 2003 Editions, what products make up the Microsoft Office System?

A. Microsoft Office System includes:

· Editions 

· Microsoft Office Professional Enterprise Edition 2003 

· Microsoft Office Professional Edition 2003 

· Microsoft Office Standard Edition 2003 

· Microsoft Office Small Business Edition 2003 

· Microsoft Office Student and Teacher Edition 2003 

· Microsoft Office Basic Edition 2003 

· Programs 

· Microsoft Office Word 2003 

· Microsoft Office Excel 2003 

· Microsoft Office Outlook® 2003 

· Microsoft Office Outlook 2003 with Business Contact Manager 

· Microsoft Office PowerPoint® 2003 

· Microsoft Office Access 2003 

· Microsoft Office FrontPage® 2003 

· Microsoft Office OneNote™ 2003 

· Microsoft Office Publisher 2003 

· Microsoft Office Project Standard 2003 

· Microsoft Office Project Professional 2003 

· Microsoft Office Visio Standard 2003 

· Microsoft Office Visio Professional 2003 

· Microsoft Office InfoPath™ 2003 

· Servers 

· Microsoft Office Project Server 2003 

· Microsoft Office SharePoint™ Portal Server 2003 

· Microsoft Office Live Communications Server 2003 

· Services 

· Microsoft Office Live Meeting 

· Solutions 

· Microsoft Enterprise Project Management (EPM) Solution 

· Microsoft Office System Solutions Gallery 
Complementary Microsoft Products and Technologies

· Microsoft Windows® SharePoint Services 

· Microsoft Windows Server™ 2003 

· Microsoft Exchange Server 2003 
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Office 2003 Editions
Q. What are the major changes between Office 2003 Editions and Office XP?
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A. The core programs in Office 2003 Editions include many significant changes. Some of these changes include:

· Broader XML will be available in Microsoft Office Word 2003, Excel 2003, and Microsoft Office Access 2003, and offer schemas you can customize for consuming data, smart documents, and programmable task panes and Research task panes. 

· Greater integration with Windows SharePoint Services, with increased collaboration through team sites, Document Workspaces, Meeting Workspaces, and other tools. 

· A redesigned version of Outlook 2003 with an improved reading pane, smart folders, cached memory, e-mail conversation thread condensers, and many more improvements. 

System Requirements

To use Office 2003 Editions, you need:
	Component

	Requirement


	Computer and processor

	Personal computer with an Intel Pentium 233-megahertz (MHz) or higher processor, Pentium III recommended


	Memory

	128 megabytes (MB) of RAM or above recommended


	Hard disk

	Hard disk usage will vary depending on configuration; custom installation choices may require more or less hard disk space. Listed below are the hard disk requirements for individual Office 2003 Editions.

Microsoft Office Standard Edition 2003 

· 260 MB of available hard disk space 

· Optional installation files cache (recommended) requires an additional 250 MB of available hard disk space 


Microsoft Office Professional Edition 2003 

· 400 MB of available hard disk space; 190 MB of hard disk space for Microsoft Office Outlook® 2003 with Business Contact Manager 

· Optional installation files cache (recommended) requires an additional 290 MB of available hard disk space 

Microsoft Office Small Business Edition 2003 

· 380 MB of available hard disk space; 190 MB of additional hard disk space to use optional installation of Outlook 2003 with Business Contact Manager 

· Optional installation files cache (recommended) requires an additional 280 MB of available hard disk space 

Microsoft Office Student and Teacher Edition 2003 

· 260 MB of available hard disk space 

· Optional installation files cache (recommended) requires an additional 250 MB of available hard disk space 


	Operating system

	Microsoft Windows® 2000 with Service Pack 3 (SP3) or later; or Windows XP or later


	Display

	Super VGA (800 × 600) or a higher-resolution monitor



	


For Microsoft Windows SharePoint Services and Portal Server Supported Platforms
· Windows .NET Server & IIS 6.0 (worker process isolation mode only) 

· Windows .NET Advanced Server & IIS 6.0 (worker process isolation mode only) 

· Windows .NET Data Center Server & IIS 6.0 (worker process isolation mode only) 

· MSDE 2000 SP 2 (will be SP 3 once it ships) 

· SQL 2000 SP 2 (will be SP 3 once it ships) 
Retail Pricing and SKUs
	Office 2003 Editions
	New User Price
	Upgrade Price

	Microsoft Office Student and Teacher Edition 2003
	$149 US
	Not available

	Microsoft Office Standard Edition 2003
	$399 US
	$239 US

	Microsoft Office Small Business Edition 2003
	$449 US
	$279 US

	Microsoft Office Professional Edition 2003
	$499 US
	$329 US
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Q. What happened to the Office Developer Edition?
A. Microsoft has integrated the Office developer tools into the professional developer tools of Visual Studio:  Visual Studio Tools for Office with Visual Studio 2003.  More information on tools for developers for Office 2003 can be found at MSDN website (Microsoft Developer Network) http://msdn.microsoft.com/vstudio/office/

File Compatibility

Programs
Q. Will I have problems sharing Office 2003 Editions files with people running previous versions of Office? 
A. Programs in Office 2003 Editions can open files created by Microsoft Office XP, Office 2000, and Office 97. Similarly, files created with programs in Office 2003 Editions can be opened by each of these prior versions (with the exception of Microsoft Access).
Users of Access 2000 or earlier: Access 2003 will use the Access 2000 file format by default. If you choose to use the updated file format for Access 2003, those files will not work with Access 2000).

Keep in mind that new features in Office 2003 Editions might not be available or may look different in earlier versions of Microsoft Office.

A detailed technical article on file sharing, including comparison tables of Office 2003 specific features than will not migrate to ALL older versions of Office can be found on the Microsoft Technet website:  “Microsoft Office 2003 and File Sharing in a Heterogeneous Office Environment”  http://www.microsoft.com/technet/treeview/default.asp?url=/technet/prodtechnol/office/office2003/plan/of03irm.asp
Installation
Q: Can Office 2003 be installed alongside Office XP on the same PC?                                                            A: Yes except you will need to run a single version of Outlook.

SPECIFIC APPLICATIONS

Word 2003

Q. Doesn't the reading layout view make the web layout view redundant? 

                       
A. They're quite different. Web layout does layout like a web browser - i.e. wrap lines at the window width (meaning they can be 15" long), and uses scrolling to read. Reading layout builds a much more readable page appearance, and flips pages rather than scrolling.

Q: You were also able to click on the question mark in a Word window to obtain additional online information about a particular option. Is this still available?  

A: Yes, the question mark “What’s this?” was removed for most (but not all) dialogs. You can still get to this through SHIFT+F1 and it will bring up help.


Q. If someone has a really old version of Word (pre Word 97) will they need a document reader?  

A.  Microsoft changed the file format with Word 97, so in Word 2003 you need to “save as” a previous version.  

Q. In Office XP if you were in a document with a Smart Tag and made no changes you would still be asked if you wanted to make changes.  Has this been fixed?
A. Smart tags query a variety of things such including names, financial symbols and dates. We recommend you submit an email to Microsoft support with specific details on when you’ve encountered this issue in order to better resolve it for you.
Q. Can you create a clipboard icon on your desktop like you were able to in Office 97?

A. Yes, when your clipboard is turned on, you can choose to show it on the task bar (bottom right corner of screen.
To do this:
1. Display the Microsoft Office Clipboard in the task pane (task pane: A window within an Office application that provides commonly used commands. Its location and small size allow you to use these commands while still working on your files.). 

· On the Edit menu, click Office Clipboard. 

2. On the Clipboard task pane, click Options. 

3. Set the command options you want: 

	Option
	Description

	Show Office Clipboard Automatically
	Automatically displays the Microsoft Office Clipboard when copying items.

	Show Office Clipboard When CTRL+C Pressed Twice
	Automatically displays the Office Clipboard when CTRL+C is pressed twice.

	Collect Without Showing Office Clipboard
	Automatically copies items to the Office Clipboard without displaying the Office Clipboard.

	Show Office Clipboard Icon on Taskbar
	Displays the Office Clipboard icon [image: image8.png]


in the status area of the system taskbar when the Office Clipboard is active.

	Show Status Near Taskbar When Copying
	Displays the collected item 


Q. What XML support is provided in Word 2003?[image: image9.png]



A. XML support was added to Word 2003 to enable developers to build powerful solutions with which end users can easily interact. The W3C standards-compliant XML support is built upon Microsoft XML Core Services (MSXML). Some of the features supported include the following:

· A native XML document schema (save as XML) 

· Support for customer-defined XML schemas to create structure in documents 

· Rich XML Document Object Model (DOM) programmability through Microsoft Visual Basic® for Applications (VBA) 

· XML content repurposing through XML Path Language (XPath) and Extensible Stylesheet Language Transforms (XSLT) 

· XML schema (XSD) validation as a user types 

· Opening, saving, and viewing XML documents through XSLT 

· User-based editing restrictions and style locking according to the XML structure 

Q. Will Dragon Naturally Speaking V.7 work with the new Microsoft Office System?

A. While we have not tested it ourselves, Dragon representatives do claim that it will work with the new Office version.

Excel 2003

Q. What is a smart document?

A. Smart documents are programmed to extend the functionality of your workbook by dynamically responding to the context of your actions. Several types of workbooks, especially workbooks that are used as part of a process such as forms and templates, work well as smart documents. Smart documents can help you reuse existing content and can make it easier to share information. They can interact with a variety of databases and use BizTalk® for tracking workflow. They can even interact with other Office programs such as Microsoft Outlook®, all without leaving the workbook or starting Outlook.

Q. How can you compare workbooks?

A. Use a new approach to compare workbooks—compare workbooks side by side. Comparing workbooks side by side (using the Compare Side by Side with command on the Window menu) allows you to see the differences between two workbooks more easily, without having to merge all changes into one workbook. You can scroll through both workbooks at the same time to identify differences between the two workbooks.

Q. Is it easier to create lists in Excel 2003?
A. You can create a list on existing data or create a list from an empty range. When you specify a range as a list, you can easily manage and analyze the data independent of other data outside of the list. Other enhancements to list functionality are:
· A new user interface and a corresponding set of functionality are exposed for ranges that are designated as a list.

· Every column in a list has AutoFilter enabled by default in the header row which allows you to quickly filter or sort your data.

· A dark blue list border clearly outlines the range of cells that compose your list.

· A row in the list frame that contains an asterisk is called the insert row. Typing information in this row will automatically add data to the list.

· A total row can be added to your list. When you click on a cell within the total row, you can pick from a drop-down list of aggregate functions.

· The size of a list can be modified by dragging the resize handle found on the bottom right corner of the list border.

Q. Can you share Excel lists on a SharePoint Web site?

A. You can create a Windows SharePoint Services list based on your Excel list on a Windows SharePoint Services site by publishing the list. If you choose to link the list to the Windows SharePoint Services site, any changes you make to the list in Excel will be reflected on the Windows SharePoint Services site when you synchronize the list. You can also use Excel to edit existing Windows SharePoint Services lists. You can modify the list offline and then synchronize your changes later to update the Windows SharePoint Services list.
Q.  How does the XML support in Excel 2003 differ from XML support in Excel version 2002?

A.  In Office XP, Microsoft introduced the capability for Excel spreadsheets to be saved as XML. This enabled many new methods for getting data into and out of Excel using XML and Web services. With Office Professional Edition 2003, Microsoft has greatly increased the XML capabilities of Excel 2003 by providing support for XML structure in spreadsheets according to any World Wide Web Consortium (W3C)-compliant customer-defined XML schema. This allows customers to do all of the following and more with Excel:

· Load a customer-defined schema and map the XML elements to a spreadsheet model 

· Load XML directly into a worksheet that has been mapped to a schema 

· Aggregate multiple XML sources together into a list defined by a schema 

· Export or save XML from Excel in the form of either Excel spreadsheet XML or a customer-defined XML schema 

· Build a custom application based on an underlying XML structure that can present users with help content or corporate data pertinent to the active spreadsheet cell (a smart document solution) 

PowerPoint 2003

Q. Which versions of Windows does the PowerPoint viewer work with?
A. The updated Viewer runs on Microsoft Windows® 98 Second Edition or later.
Q: Will PowerPoint 2003 support web based streaming media (audio/video) more effectively?

A: Yes. PowerPoint 2003 supports streaming media via Windows Media Player. This includes streaming support for file formats including ASX, WMA, WMV.
Q: Does PowerPoint 2003 support smart tags?

A: Yes. Smart tag support has been added to PowerPoint. By selecting AutoCorrect Options on the Tools menu, and then clicking the Smart Tags tab, you can choose to label text in your presentation with smart tags. Dates, financial symbols, and person names are included in the list of smart tag recognizers that ship with PowerPoint.
Q: My company produces a lot of content for the web using flash animations. We would like to incorporate these in client PowerPoint presentations. Will PowerPoint 2003 support flash swf files?
A: Support for flash animations in PowerPoint 2003 is the same as it has been for the last several releases, through the use of ActiveX control. For more info: http://www.rdpslides.com/pptfaq/FAQ00049.htm
Q: The new package for CD is great! But, what is the best format for video (MPG, AVI, WMV). I've been using WM9 but have found the majority of clients don’t have the right codec and are not capable enough to download it. Can the codec be on the CD?
A: It is technically possible to include the codec installation on the CD. The codecs may be downloaded from: http://www.microsoft.com/windows/windowsmedia/format/codecdownload.aspx
Q: Will PowerPoint offer the ability to export to DVD?                                                                                             A: this article on ZDNET mentions an upcoming 3rd party solution for this. http://zdnet.com.com/2100-1104_2-1024566.html.  CDs can hold over 600MB. Also, you can Package to Folder and then burn to a DVD which gives you up to 4.7GB.

Publisher 2003

Q. What is new in Publisher 2003? 

A. Publisher 2003 includes many new and improved features designed to help business users design, create, and publish professional marketing and communication materials in-house, including:

· Enhanced support for the Web. Create a marketing Web site with new Web site wizards, built-in support for more than 20 new Web page types, enhanced navigation bar support, and other improved features. You can make changes easily by uploading incremental changes to a Web file. 

· 10 new Master Design Sets. Create a consistent look across business publications with new Master Design Sets, which are collections of templates that carry a consistent design theme across publications. Choose from 45 Master Design Sets in Publisher 2003. 

· Enhanced design tools. Polish your publications with an improved Design Checker, support for multiple master pages, tools to align baselines, and tools to control widows and orphans. 

· Enhanced commercial printing support. Take advantage of support for process color (CMYK) composite postscript printing and the improved Graphics Manager. 

· Catalog Merge. Create publications by merging text and photos from a data source, such as Microsoft Office Excel 2003 or Microsoft Office Access 2003. 

· Enhanced support for e-mail publications. Use the new e-mail wizard to create various types of marketing e-mail messages, such as newsletters and product or service announcements. Microsoft Publisher version 2002 limits which customers can view e-mail messages created by Publisher. In Publisher 2003, customers can view messages using various e-mail and Web-based clients, including Microsoft Office Outlook® 2003, Microsoft Outlook Express 5.0 or later, Microsoft Hotmail®, Yahoo mail, and AOL mail. 

For a complete list of new and improved features, see the Publisher 2003 Reviewer's Guide.

Q. Can I modify photos using Publisher 2003?
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A. Yes. Using Publisher 2003, you can accomplish basic photo-editing tasks such as cropping, resizing, and recoloring. 
Q. Can I open and edit files created in Publisher 2003 in previous versions of Publisher?
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A. Publisher 2003 files can be opened and edited in Publisher 2002 only, as they share the same file format. To open and edit Publisher 2003 files in Microsoft Publisher 2000, on the File menu, click Save As. In the Save as type box, click Publisher 2000 Files (*.pub).

Q. Can I use Publisher 2003 to work on files created in previous versions of Publisher?
A. Yes. Microsoft Office Publisher 2003 files can be opened and edited in Publisher 2003 as well as Publisher 2002, as they share the same file format. To open and modify Publisher 2003 files in Publisher 2000 or Microsoft Publisher 98, simply save your files to the previous version: On the File menu, click Save As. In the Save as type box, click Publisher 2000 Files (*.pub) or Publisher 98 Files (*.pub).
Q: Does Publisher 2003 support conversion to PDF files? 

A: Yes. However, you also need an additional tool, such as Distiller to do this. The new CMYK Composite Postscript output feature provides appropriate output to be able to generate CMYK PDF for commercial printing. Of course, you can generate RGB PDF for purposes such as online sharing by installing the Distiller printer driver, or another compatible tool.   The new CMYK Composite Postscript output feature provides appropriate output to be able to generate CMYK PDF for commercial printing. You can generate RGB PDF for purposes such as online sharing by installing the Distiller printer driver, or another compatible tool.

Outlook 2003

Q: Are Outlook file size (.pst) limitations larger than previous versions?  What is the size restriction now?
A: If you are using the default (Unicode) for Office 2003 it is approx. 20 Gig.

Q: Will the icon for Outlook return to the desktop? This was very useful in Office XP - the icon ONLY appears in Windows 2000 - and NOT Windows XP.
A: This is a tough issue. When we first made this change for Office XP, it was quite controversial to put it on the desktop. Many users do not want icons and shortcuts cluttering their Windows Desktop. On Windows XP, the same special properties possessed by the Desktop icon are assigned to the Outlook icon at the top of the default Start Menu.
Q: Has Outlook been improved to support reading News Groups like Outlook Express?

A:  Use newsreaders to gain access to various types of newsgroups (newsgroup: A collection of messages posted by individuals to a news server, a computer maintained by a company, group, or individual. Some newsgroups are monitored, but most are not, and messages can be posted and read by anyone with access to the group.), to download and read news messages, and to post replies to them. Newsgroups are a valuable source of information where you can find what your peers think and get information from people who use the same products and technologies you use. You can find newsgroups on practically any subject, and a newsgroup can be an Internet Usenet group or an internal company newsgroup.
If you have not previously set up a newsreader, Microsoft Outlook automatically sets up the Outlook Express Newsreader. This newsreader is a Network News Transport Protocol (NNTP) newsreader, which you can use to download newsgroup content and then work with it when you are not connected to the Internet. You can also browse most newsgroups using your Web browser.
You can send someone the URL of a newsgroup in an e-mail message, and when they double-click the link, their default newsreader will start.
Q: Does the spam filter check against your address book to make sure no one in your contacts gets put in the Junk Mail folder?

A:  You can include your Contacts as Safe Senders
1. On the Tools menu, click Options. 

2. Click Junk E-mail. 

3. Click the Safe Senders tab. 

4. Select the Also trust e-mail from my Contacts check box.

Notes
· When you select this option, you will not see Contact e-mail addresses in the list. However, all e-mail addresses in your Contacts folder will be used by the Junk E-mail Filter to evaluate messages. 

· If you are using a Microsoft Exchange Server e-mail account and working online, you must be using Microsoft Exchange Server 2003 or later. If you do not know what version of Exchange server your e-mail account is using, contact your Exchange administrator.
One Note 2003

Q. What is OneNote, and what does it do?

A. OneNote 2003 is a new program in the Microsoft Office System. It enables you to capture, organize, and reuse your notes electronically on laptop computers, desktop computers, or Tablet PCs. OneNote 2003 gives you one place for all your notes, and the freedom to organize them the way you want. It also helps you capture information in multiple ways and then organize and reuse that information according to your needs—helping you work with your notes and information more productively.

Q. Who can use OneNote?

A.  OneNote can help anyone get more from their notes and information. It can be used to capture notes in multiple formats and then easily organize, access, search, reuse, and share them. For example, you can use OneNote to:

· Organize notes and information quickly and easily. 

· Take notes and structure information the way you want. 

· Find valuable information quickly regardless of where you saved it. 

· Reuse notes in other OneNote notebooks and other Microsoft Office programs, such as Microsoft Office Word, Microsoft Office Outlook®, and Microsoft Office PowerPoint®. 

· Capture information in various formats—such as by typing, recording audio, handwriting, or drawing. 

· Prioritize action items and urgent information. 

· Share your notes. 

· Avoid spending time transcribing handwritten notes. 
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Q. Will OneNote 2003 be included in Microsoft Office 2003 Editions?
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A.  No. OneNote 2003 is available as a stand-alone program only; it is not included in any of the Office 2003 Editions. Learn more about what programs are available in Office 2003 Editions.
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Q. Do I need to install OneNote with other programs in Office 2003 Editions?

A. No. OneNote works as a separate, stand-alone program without the other Office 2003 Editions programs. However, some enhanced features are available if you have installed both OneNote and other Microsoft Office System programs. For example, customers with both OneNote and Outlook 2003 can send their notes in an e-mail message simply by clicking one button within OneNote.
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Q. Does OneNote work with earlier versions of Office?

A. Yes. OneNote 2003 works with earlier versions of Office, such as Office 97 and Office XP. However, certain features of OneNote that integrate with Office programs, such as the ability to create Outlook tasks directly from OneNote or to send notes directly from OneNote through e-mail, will not be available with versions of Office earlier than Office 2003 Editions.
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Q. How does OneNote integrate with other Microsoft Office System programs?
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A.  While OneNote 2003 is a stand-alone program, it also integrates with other Microsoft Office System programs. For example, in OneNote you can:

· Use the Clipboard to copy and paste to and from other files created with Microsoft Office programs. 

· Add Note Flags to your tasks in Outlook 2003. 

· Send your notes as an e-mail attachment or as Hypertext Markup Language (HTML) in an Outlook 2003 e-mail message. 

· Use your custom dictionary from Word 2003. OneNote shares dictionaries with the other programs in Office 2003 Editions so any words you add to your custom dictionary in another program are recognized in OneNote. 

· Use the Research task pane to look up information from an intranet or the Web, as well as online dictionaries, encyclopedias, thesauruses, translation services, and reference materials. 

· Search OneNote files with Microsoft SharePoint™ Portal Server using an IFilter for OneNote. 

· Create a shared workspace on a Microsoft Windows® SharePoint Services site, and open the Shared Workspace task pane in a Web browser or another Microsoft Office program. 

Note: The Shared Workspace task pane is available with Windows SharePoint Services only.
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Q. Which languages will OneNote 2003 be able to recognize handwriting in? 
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A. Because OneNote 2003 uses the handwriting recognition engine in the Microsoft Windows XP Tablet PC Edition, OneNote recognizes handwriting in the same languages that the Tablet PC does: English, German, French, Japanese, Chinese (Simplified and Traditional), and Korean. Tablet PC and OneNote will be able to recognize handwriting in more languages in the future.
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Q. How does OneNote work with Tablet PC? 
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A. OneNote has enhanced capabilities that enable people using Tablet PCs to handwrite notes or draw diagrams with digital ink—a new technology from Microsoft for working with handwriting as if it were text. You can both handwrite and type notes on the same page. The features of typed text notes in OneNote are also available with digital ink notes, such as bullets and numbering, converting handwritten notes to text, and searching handwritten notes.

If you don't have a pen-input device, you can use your mouse to draw and sketch diagrams in OneNote.
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Q. Is OneNote only for Tablet PCs?
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A. No. You don’t need a Tablet PC to use OneNote. OneNote can help you capture, organize, and reuse your notes easily and effectively on a laptop, desktop, or Tablet PC. OneNote offers some enhanced capabilities on a Tablet PC, such as the ability to handwrite your notes in digital ink, and then search your notes or convert them to text.
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Q.  Can I still handwrite notes in OneNote if I don't have a Tablet PC?

A.  Yes. You can still capture your handwritten notes in OneNote with a mouse or a third-party pen-input device. However, these handwritten notes will be saved as pictures and not as handwritten digital ink, which means that while these notes resemble your handwriting, you will not be able to search them or convert them into text.

OneNote uses the capabilities of the Windows XP Tablet PC Edition operating system for ink support. When you are not on a Tablet PC, OneNote no longer has access to the handwriting recognition engines of the Tablet PC. As a result, OneNote treats all handwritten notes when not on a Tablet PC as ink that is intended to be a picture or drawing (no searching, no recognition capability). 
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Q.  What are the system requirements for OneNote 2003?

A.  

	Component
	Requirement

	Computer and processor
	Personal computer with an Intel Pentium 233-megahertz (MHz) or higher processor, Pentium III recommended

	Memory
	128 megabyte (MB) of RAM or above recommended

	Hard disk
	100 MB of available hard disk space (Hard disk usage will vary depending on configuration; custom installation choices may require more or less hard disk space.)

Optional installation files cache (recommended) requires an additional 100 MB of available hard disk space. 

	Operating system
	Microsoft Windows® 2000 with Service Pack 3 (SP3) or later; or Windows XP or later

	Display
	Super VGA (800 × 600) or a higher-resolution monitor


Q.  Does OneNote Have Interoperability with the Pocket PC?

A.  OneNote 2003 does not interoperate with the Pocket PC or other Personal Digital Assistants (PDAs). This is an area that Microsoft is investigating for future releases of OneNote.

Q.  Can I Import or Insert Other File Types Such As Microsoft PowerPoint® Files Into OneNote?
A.  You cannot import or insert other file types into OneNote. You can copy information from other file types onto the Office clipboard and then paste it into OneNote.

Q.  Can I Export OneNote Files Into Other File Types?
A.  You can only save OneNote files as .one files or MHTML files. You can copy information from OneNote onto the Office clipboard and then paste it into other programs such as Microsoft Word or Microsoft PowerPoint.

Q.  Can I Create a Task in OneNote and Have It Appear in Outlook?

A.  You can add any paragraph of notes from OneNote 2003 to your Tasks in Outlook 2003 by right-clicking on that note and choosing Create Outlook Task. This feature will not work with previous versions of Outlook.

Q.  Once I Have Created an Outlook Task with a Note in OneNote, Will They Be Synchronized? in Other Words, if I Change or Delete That Task in Outlook, Will It Also Be Automatically Changed or Deleted in OneNote?

A.  No, while you can add any paragraph of notes within OneNote 2003 to your tasks in Outlook 2003, they are not synchronized afterwards. In other words, changes you make to your tasks in Outlook 2003 will not automatically be reflected in OneNote.

Q.  How Does OneNote Work with Microsoft Windows Sharepoint Services (WSS)?

A.  You can create a shared team notebook with OneNote 2003 and WSS, which results in a Shared Workspace pane within OneNote 2003. This will create a shared team notebook section that “lives” within each team member’s OneNote 2003. Note that WSS requires Windows Server 2003.

Q.  Does OneNote Work with Earlier Versions of Office?

A.  Yes. OneNote 2003 works with earlier versions of Office, such as Office 97 and Office XP. However, certain features of OneNote that integrate with Office, such as the ability to create Outlook tasks directly from OneNote or to send notes directly from OneNote as e-mail messages, are not available with versions of Office earlier than Office 2003.

Q.  How Do I Copy and Paste Content from a Web Page or Other Documents Into OneNote?

A.  Simply select the content you would like to copy from a Web page or other document (such as a Microsoft Word or Microsoft PowerPoint document), and then drag it into OneNote. OneNote will enable you to easily capture text, charts, photos, and other graphics from the Web. Note that hyperlinks embedded or attached to pictures or text in a Web page or other documents will not copy properly into OneNote 2003, as the links will be lost.

Q.  How Can I Use Side Notes to Help Me Copy and Paste Content from the Web or Other Documents Into OneNote?

A.  Opening up a side note is a convenient way to capture lots of information from the Web or other documents. Simply open a side note window and it will “float” or stay open on top of your Web browser or other programs, making it easy to drag content into OneNote. 

Q.  If I Paste Some Content from Excel Into OneNote, How Would It Be Stored?

A.  OneNote will preserve all of the values and the layout of the data from Excel (numbers and text will be in tabular form). However, OneNote does not recognize formulas and will not actually retain the table formatting. You can choose to paste information from Excel into OneNote as a picture to maintain the table look.

Q.  What Is the Horizontal Gray Bar That Appears Above My Notes?

A.  This horizontal gray bar is the “handle” for a container of notes. It enables you to move and resize any container.

To move the container: 

1. Move your mouse pointer until it rests over the handle. The pointer changes from an arrow into a crosshatch. 

2. Press and hold the mouse button to “pick-up” the container. 

3. You can then easily drag that entire container of notes anywhere on the page. 

4. To resize the container: 

5. Place your mouse pointer over the horizontal arrows on the upper-right side of the bar. Your pointer will change to the resize arrow. 

6. Press and hold the mouse button to grab the corner of the container. 

7. Drag the arrows left or right to make the container wider or narrower. 

Q.  When I Am Taking Notes Using Ink, How Do I Add More Space When I Get to the Bottom of a Page?
A.  When you are taking notes using ink, there are three ways to add more space when you get to the bottom of the page: 

1. You can use the vertical scroll bar to add an extra line by clicking the down arrow. 

2. You can add a half page of space by clicking the double arrow button underneath the scroll bar. 

3. You can create more space by clicking Extra Writing Space in the Insert menu. This will cause a horizontal bar to appear on the page. Moving your mouse will move the horizontal bar to different places on the page, so that you can create more space anywhere you need it. To create more space at the bottom of the page, move the bar to the bottom of the page, click and hold down the mouse button, then drag upwards to create as much space as you need. 

Another option is to create new pages or subpages in a page group. If you create a new subpage (by clicking the New Subpage page tab), you get a new page in the page group that shares the same title as the main page. This is like adding a second sheet to a set of notes in your notebook.

Q.  Does OneNote Support Grammar Check?

A.  No.

Q.  Can I Have Both Typed Notes and Handwritten Notes on the Same Page in OneNote?

A.  Yes.

Q.  Can I Write and Have the Ink Recognized in the Title?

A.  Yes, you can write with digital ink in the title region. The title area remains as ink handwriting. If you are using OneNote on a Tablet PC, the handwritten title is automatically converted to text in the label on the corresponding page tab.

Q.  How Does the Handwriting Recognition Technology Used By OneNote Work?

A.  OneNote 2003 uses the handwriting recognition technology of the Windows XP Tablet PC operating system. The handwriting recognition technology is based on the careful analysis of millions of handwriting samples from different people all over the world, so that handwriting recognition occurs as naturally and intuitively as possible as soon as you start handwriting in OneNote on a Tablet PC.

Q.  Do I Have to Train the Handwriting Recognition Technology Used By OneNote to Recognize My Handwriting? Does It Adapt to My Handwriting Over Time?

A.  No. The handwriting recognition technology of OneNote and Tablet PC is designed so that handwriting recognition occurs as naturally and intuitively as possible as soon as you start handwriting. You cannot train the handwriting recognition engine in OneNote and Tablet PC to adapt to your own handwriting.

Q.  Can OneNote Recognize My Handwriting on a Tablet PC if I Write on a Diagonal?

A.  No, OneNote 2003 can recognize your handwriting only if the digital ink is written horizontally. OneNote 2003 treats handwriting on a diagonal as a drawing.

Q.  Can I Do a Search on Handwritten Notes?

A.  You can search the handwritten notes that were created by using OneNote on a Tablet PC in the same manner you can search typed text notes. You cannot search words that are in drawing format—you must first choose to treat them as digital ink before you can search them (click Treat Selected Ink As in the Tools menu and choose Handwriting). Note that you can only search handwritten notes in OneNote that were created on a Tablet PC. For more information see the questions about how OneNote works with a Tablet PC. 

Q.  Do AutoCorrect and the Spelling Checker Work with My Handwritten Notes in OneNote?
A.  No, AutoCorrect and the spelling checker do not work with handwritten digital ink in OneNote. If you wrote those notes in OneNote on a Tablet PC, you can first convert them to text, and then AutoCorrect and spell check will work on those text notes.

Q.  Can I Scan Handwritten Notes Into OneNote and Convert Them to Text?

A.  No, only handwritten digital ink notes that were created by using OneNote on a Tablet PC can be converted into text.

Q.  Does OneNote Work with Third-Party Pen-Input Devices? Can I Create Digital Ink in OneNote with These Devices?

A.  OneNote uses the capabilities of the Windows XP Tablet PC Edition operating system for its ink support. So on a Tablet PC, you can capture ink in OneNote with the Tablet PC pen, a mouse, or a third-party digitizer pad or pen.

However, the quality of the ink captured varies with the device and the software driver it uses. For example, the tablet pen can capture your ink at more than 130 samples per second. This means that a lot of data is captured about the motion of the pen, and as a result, the quality of the ink that results is better. Likewise, the quality of handwriting recognition is better. A mouse or external device that uses the mouse interface samples at around 40 samples per second, resulting in lower accuracy of the ink and handwriting recognition.

When you are not using a Tablet PC, OneNote no longer has access to the handwriting recognition technologies of the Tablet PC. As a result, although you can still capture digital ink in the same ways as on the Tablet PC, the sample rate is the lower 40 samples per second, and the ink cannot be converted to text. The ability to search handwriting also depends on the recognition technologies, so that capability is not available either.

As a result, OneNote treats all ink it receives when not on a Tablet PC as ink that is intended to be a drawing (with no search and no recognition capability). The commands for entering ink that OneNote treats as handwriting are unavailable when using OneNote when not on a Tablet PC.

Some add-on pen peripherals have additional capabilities of their own to capture images of your handwriting. Such pens may be able to integrate with OneNote in a limited way, such as by pasting a bitmap picture of your writing (as opposed to true digital ink), but this depends on the manufacturer’s software.

Side Note

Q.  What Does the Side Note Feature in OneNote Do?
A.  OneNote enables you to quickly create a side note, which is a small window that is another instance of OneNote. You do this by clicking the OneNote icon on the taskbar. This starts OneNote in miniaturized format on the right half of your screen. You can also open up a side note using the keyboard shortcut Windows Key+M.

The side note is handy for taking down quick reminders, such as phone numbers, addresses, quick to-dos, or other action items. The great thing is that all of this information is captured in a Side Notes section in OneNote—all you have to do is maximize the small window and you see the full OneNote program. (And vice versa—if you shrink the full OneNote window so that it is about one-fourth the normal size, it becomes the window for taking side notes.)

You can also use side notes to capture your research information. By default, when you open a side note window, it will “float” or stay open on top of all of your other programs. This makes it really easy to drag photos, pictures, diagrams, text, or other content directly into OneNote from the Web or from other programs. You can always choose to “unpin” a side note by clicking on the Keep Window on Top button (which looks like a pushpin) on the side note, which will cause it to stop “floating” on top of your other programs.

Q.  Where Do the Notes or Information That I Capture in the Side Note Window Go? Can I Choose Which Notebook Section This Information Goes To?

A.  By default, OneNote puts the notes and information you capture in the side note window into a section called Side Notes. This folder is automatically created for you the first time you take notes in the side note window.  There are two ways to change where OneNote stores the information you capture in the side note window: 

You can change the default section used by the side note window by going to the Tools menu, clicking Options, and then in the Open and Save category, changing the default location of Side Notes Section under Path. 

If you shrink OneNote to the miniature window while a particular section is open, that section stores the information you capture in the miniature window. 

Q.  Do I Need an External Microphone or Other Hardware to Record Linked Audio Notes?
A.  Built-in microphones for each computer vary greatly. Generally, the built-in microphone works well for recording your own voice or a small meeting of two or three people. However, the OneNote team recommends an external microphone for best results, especially in larger meetings or when recording presentations or lectures.

Q.  Do I Need Special Software Other Than OneNote to Enable Audio Notes?
A.  In order to record and play back audio, you need Windows Media® Player 8 and Microsoft DirectX® 8.1 application programming interface or later, which is supported in Windows XP. If you're using Windows 2000 SP3, you should upgrade to the latest version of Windows Media Player and DirectX. Regardless of which operating system you are running, Windows Media Player 9.0 or later and DirectX 9.0a or later are recommended for best results.

Q.  How Are Audio Recordings Saved?

A.  Audio recordings are saved as Windows Media Audio (.wma) files. These .wma files are saved in the same folder as the associated .one files (notebook sections). If your page had a title before you began recording, the associated .wma file has the same title. Otherwise, it is named “Audio Recording.WMA.”

Audio files must be kept in the same folder as associated .one files to maintain the link between typed or ink notes and the audio files. If you move a .one file within OneNote (such as by right-clicking a section tab and choosing Move), OneNote will automatically move the associated audio files to the new location as well. If you choose to move .one files using Windows Explorer, your associated audio files will not be moved automatically.

Q.  How Do I Delete My Audio Recordings? If I Delete the Notes Associated with an Audio File, Is the Audio Recording Also Deleted?

A.  Deleting notes associated with an audio recording does not delete the audio file. You can delete individual audio files by clicking Audio Recording on the Tools menu and then clicking Delete Recording. Note that deleting a page or page group will delete all audio files associated with that particular page or page group.

Q.  Why Does OneNote Cut Off the First Three or Four Seconds of My Audio Recording?

A.  The audio technology in OneNote 2003 takes three or four seconds to start running. In other words, OneNote does not instantly record when you click Record. You need to wait three or four seconds for the audio engine to start. When OneNote inserts the time and date stamp, you can tell that the audio recording has started.

Q.  Can I Search Across My Audio Notes?

A.  There is no method to search across the actual audio portion of the recordings. However, since OneNote links your audio recording to the typed or written notes that you took at the time, you can easily search your notes as a proxy for searching your audio notes.

Q.  Does OneNote Automatically Send Associated Audio Files When I Send My Notes in E-Mail?

A.  By default, OneNote sends the written notes only. If you want to send the audio recordings, you can go to your My Notebook folder and attach the audio file.

You can also set the default to automatically send associated audio files whenever you send your notes in e-mail (note that your audio files may be quite large). To do this, on the Tools menu, click Options. In the E-mail category, select the Attach a copy of linked audio files check box.

Q.  Does OneNote Copy Audio Files to the Web When Publishing Notes As HTML?

A.  Yes, OneNote will publish the audio files associated with your pages or page groups.

Organizing Information More Efficiently 



Q.  What Is the Relationship Among Folders, Sections, Pages, Page Groups, and Subpages in OneNote?

A.  OneNote is a digital notebook that gives you the freedom to work the way you want, because you can organize your notes in the way that makes most sense to you. The different structures in OneNote are: 

Folders. These are file folders that are similar to the file folders in your My Documents folder. You can add more folders or notebook sections to folders. However, you cannot put pages or subpages into a folder—those can be added to sections only. You might think of the folders as “dividers” in a three-ring binder. OneNote starts with one suggested folder called My Notebook, which is placed in your My Documents folder. You can create as many other folders as you want by clicking New on the File menu and then clicking Folder. 

Sections. Each section is actually a separate OneNote file or .one file. The sections are represented by the tabs along the top of your notebook pages. You can think of them as “sections” in a three-ring binder. You can create as many notebook sections as you need. You can add as many pages and subpages to a section as you want, but you cannot add other notebook sections or folders. 

Pages. These are the pages of “digital paper” in your notebook. You can create as many pages as you want in each section of your notebook. 

Page groups and subpages. These are groupings of pages that address the same topic. Page groups are indicated in two ways: The pages in a page group all have the same title, and second, the subpages in a page group have shorter page tabs. You can put as many subpages as you want into a page group. Note that you cannot change the title of subpages separately—an entire page group will always have the same title. 

You can create as many folders, sections, page groups, and pages as you want and organize them flexibly as described in the preceding list.

OneNote customer field trials showed that note-taking is a highly personal behavior. Different customers organize their OneNote notebooks completely differently. For example, some customers have complex, multi-level folders, sections, and page groups. Other customers find that a straightforward arrangement of the suggested My Notebook folder with a few notebook sections is better for their needs. The point is that OneNote gives you the freedom to organize your notes the way you prefer.

Q.  How Many Notebook Sections Can I Create?

A.  You can create as many notebook sections as you want and name them however you please. You can also delete notebook sections at any time.

Q.  Can I Edit the Titles of My Page Tabs?

A.  Yes, the title of the page tabs is the same as the title that you type or write into the title area in the page header. You cannot edit the titles of your page tabs in OneNote 2003 directly by left- or right-clicking on them.

Q.  How Do I Move Pages or Page Groups Up or Down in a Section?

A.  You can move pages up and down freely in a section. Select the page you want to move by double-clicking its page tab and then drag it to a different location in the section.

Q.  How Do I Move Pages or Page Groups from One Section to Another?
A.  You can move pages freely from one section to another. Just right-click the page tab of the page you want to move, click Move Page to, click Another Section, and then select the section you want to move it to. Note that you cannot drag a page or page group from one section to another.

Deleting Pages and Sections
Q.  What Happens When I Delete a Page? Where Does It Go?

A.  When you delete a page, it goes to a folder called Deleted Pages. You can move a deleted page back into any section in your notebook as long as you have not emptied the Deleted Pages Folder.

Q.  Can I Delete a Subpage Without Deleting the Entire Page Group?

A.  Yes, to delete any subpage separately, double click the page tab for that subpage to select it, and then press DELETE.

Q.  How Do I Restore a Deleted Page or Page Group Back Into OneNote?

A.  There are two ways to restore a deleted page or page group as long as you have not emptied the Deleted Pages Folder: 

Click Deleted Pages Folder on the View menu. This reveals all of your deleted pages by section. To restore any page or page group, right click on the page tab of that page and then click Restore. 

You can also click on the drop-down tab labeled My Notebook to the left of your section tabs. Clicking on this tab will reveal the entire folder and section structure of your OneNote files. Click on the small recycle bin icon called Deleted Pages. This will also open up your Deleted Pages Folder. 

Q.  How Do I Restore a Deleted Section or .One File Back Into OneNote?

A.  Open the Recycle Bin on your desktop. Find the appropriate OneNote file, right-click it, and then click 

Restore.

Q.  What Are the Different Note Flags That I Can Use? Can I Customize Note Flags?

A.  OneNote has five suggested note flags: To Do, Important, Question, Remember for Later, and Definition. However, you can customize any of the nine note flags to make them more meaningful to you. For example, you can customize a note flag so that it has the name of a colleague to whom you send lots of follow-up items to, or one for movies that you want to rent.

To customize your note flags, on the Format menu, click Note Flags, and then click Customize My Note Flags. In the task pane that opens on the right, click any of the note flags and then click Modify. Type the name of your note flag in Display Name, and then select a symbol, font color, and highlight color for your note flag.

Q.  Is There a Way to See All of My Note Flags at Once?

A.  Yes, by clicking the Note Flags Summary button (a check box with a magnifying glass) on the toolbar or by clicking Note Flags Summary on the View menu. The Note Flags Summary task pane opens on the right. It lists all of your note flags and contains hyperlinks to where they occur on the pages of your notebook. Click a link to go to the page in OneNote where that note flag appears.

You can view your note flags in a variety of ways, such as by type, date, or title. You can also view your note flags by page, section, or in all opened sections, as well as by the date when you created each note flag.

In one glance, the Note Flags Summary task pane enables you to view all of the notes you consider important or the ones that require follow-up. You can even use the summary as your to-do list by selecting the Show only unchecked items check box. This way you can see all of your To Do items in one place.

Q.  Can I Add My Note Flags to My Outlook Tasks?

A.  Yes, you can add your note flags or any other paragraph of notes in OneNote 2003 to your tasks in Outlook 2003. On the Format menu, point to Note Flags, and then click Create Outlook Task.

Q.  Once I Have Created an Outlook Task with a Note in OneNote, Will They Be Synchronized? In Other Words, if I Change or Delete That Task in Outlook, Will It Also Be Automatically Changed or Deleted in OneNote?

A.  No, while you can add any paragraph of notes within OneNote 2003 to your tasks in Outlook 2003, they are not synchronized afterwards. In other words, changes you make to your tasks in Outlook 2003 will not automatically be reflected in OneNote.

Q.  If I Designate a OneNote To-Do Note Flag As Assigned to Someone, Will That Task Information Be Saved and Automatically Synched Up with Their Outlook Task List?

A.  No, but if you have Outlook 2003, you can convert the To-Do note flag into an Outlook task and then forward that task to the appropriate person using your Outlook email.

Q.  Can I Delete Any of the Suggested Note Flags, Such As To Do or Remember for Later, or the Ones That I Have Customized?
A.  No, in OneNote 2003 you cannot delete any of the note flags that have already been defined. You can, however, simply customize them into a different note flag if you need to change one (including the five suggested note flags the OneNote provides at first installation).

Q.  Does the Envelope Button in OneNote Work Only with Outlook 2003? If My E-Mail Client Is Anything Other Than Outlook 2003, for Example, Microsoft Outlook® XP or Eudora, Does E-Mail Integration Still Work?

A.  No, the envelope button in OneNote is integrated only with Outlook 2003.

Q.  What if I Do Not Have Outlook 2003 and I Still Want to Send My OneNote Notes in E-Mail Messages?

A.  You have several options: 

1. Attach the .one file to your e-mail message the same way you attach any other file (by using the “attach file” command in your e-mail client and going to your My Notebook folder to attach the appropriate file). Note that this method sends the entire section, and the recipients must have OneNote to open the file. 

2. Publish the notes as HTML and attach the resulting HTML file to a mail message. 

3. Copy and paste from OneNote to the other e-mail program. 

Q.  Can I Use OneNote for Web Site Publishing, Such As Posting an Online Diary, Travel Log, or Scrapbook?

A.  You can use OneNote to arrange text, drawings, photos, or other content that you have captured and then publish those notes to a Web site: 

1. Select all of the pages you want to publish. 

2. On the File menu, click Publish Pages, and then in the Save as type box, click Single File Web Page. 

3. Choose the location of your Web site. 

4. Click Publish. 

Keep your diary, travel log, or scrapbook in OneNote in a single section, and whenever you want to update your Web page, repeat the steps above (use recent files to help you get the path quicker), and then overwrite the old file when prompted.

Q.  Is There a Print Preview Zoom Feature?

A.  OneNote 2003 does not have Print Preview Zoom feature. You can resize the Print Preview window by clicking the bottom right hand corner of the dialog and dragging.

Q.  Can I Zoom in or Out on the Page in OneNote?

A.  Yes, there are two ways to zoom within OneNote: 

1. On the toolbar, click Toolbar Options (the down arrow), point to Add or Remove Buttons, point to Standard, and then click Zoom. This adds a box that shows the percentage zoom and a drop-down arrow to choose other percentages. 

2. Hold down CTRL and scroll forward or back with the wheel on your mouse. 

Q.  What Is the Level of File Locking in OneNote?

A.  OneNote 2003 locks on the .one file level—in other words, by notebook section. If you have a notebook section that is located on a network file share, OneNote locks that section only while it is the active section (in other words, the section that you are looking at currently). If other users access the file while it is locked for writing by you, they can view the file but they cannot change it.

When you move to another section within OneNote, the write lock is removed after a delay of a few minutes, and the other user can then edit the file (the other user must first click another section and then come back to re-request the lock). In this way, you can work on a section of shared notes with other people—not in real time, but as you would work in a shared log book that is added to over days and weeks.

Q.  I Have a Copy of OneNote on Two Different Computers, and I Want to Work on One Version Offline and Then Have It Automatically Synchronize When I Am Back Online. Can I Do This in OneNote?

A.  You can work offline or on different computers by using the offline files feature in Windows. To do this, select the My Notebook folder in Windows Explorer, and then choose Make Available Offline on the File menu. (Note that you may need to set up your computer to use offline files. See Windows Help for more information.) If you make changes to the same section on different computers, the Synchronize tool in Windows gives you the choice to create two versions of the same file or to discard one of them. In OneNote 2003, there is no way to automatically reconcile changes made on different computers to the same section.

Q.  How Does the Handwriting Recognition Technology Used By OneNote Work?
A.  OneNote 2003 uses the handwriting recognition engine of the Windows XP Tablet PC operating system. 

Q.  Did You Do Any Development for Left-Handed People?

A.  Yes, Microsoft is very focused on customer needs, and the OneNote team did a great deal of customer research to develop OneNote, including research with left-handed people. This research has led to features such as the ability to customize the page tabs in OneNote so that they appear on the left side rather than the right side, and being able to recognize the handwriting of left-handed people when using OneNote on a Tablet PC.

FrontPage

Q: What is new in FrontPage 2003?

A: FrontPage 2003 is the Web site creation and management program with the tools, power, and features to deliver better results. FrontPage 2003 empowers users with advances in three key areas.

· Designing: Create better-looking Web sites with the FrontPage 2003 layout and graphic design tools. 

· Coding: Generate better code more quickly with powerful scripting and editing features that push your programming to new heights. 

· Extending: Extend the power and reach of your Web site with rich interactive Webs connected to live data from a variety of sources, and a range of publishing options.

Q: What type of servers does FrontPage 2003 support?
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A: Web sites created with FrontPage can be published to any server—including Microsoft Windows® 2000, Windows NT®, and UNIX—even if it doesn't support FrontPage Server Extensions. FrontPage 2003 also provides support for publishing to both File Transfer Protocol (FTP) or Web Distributed Authoring and Versioning (WebDAV) servers. The optimal combination is to use FrontPage 2003 in combination with Microsoft Windows SharePoint Services on Microsoft Windows Server™ 2003. This allows you to access the entire set of new functionality in FrontPage 2003, along with improvements to the way you did things in Microsoft FrontPage version 2002 and FrontPage 98.
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Q: I've heard that there are no FrontPage 2003 Server Extensions. Is that true?

A: Microsoft has continued to make investments in FrontPage 2003 to enhance the overall customer experience, based on customer feedback and the changing role of server extensions in our overall product offerings. As we examined our options, it became clear that the best solution was to create a new and radically more powerful server story—Windows SharePoint™ Services—and eliminate the need for server extensions beginning with FrontPage 2003. Today, the optimal combination for FrontPage is to use FrontPage 2003 in combination with Windows SharePoint Services. This allows you to access the entire set of new functionality in FrontPage 2003, along with improvement to the way you did things in FrontPage 2002 and other previous versions of FrontPage. For more information about these changes, see FrontPage server configuration options and features.

Q: When making a "quick & dirty" ready made website, are there any advantages for using FrontPage 2003 instead of Publisher 2003?

A: FrontPage will give you control over the HTML and web design specific functionality.  Also, access to our WYSIWYG design tools that are not available in Publisher.

Q: Has the Find/Replace feature been improved? If so, how?

A: We completely re-architected the feature. Regular expression support, HTML attribute support and saving queries support for example.

Q: How easy is it to add flash in FrontPage 2003?

A: Very easy to add flash. You can insert and script using the new behaviors task pane.

Q: Are or have the table features been enhanced?

A: Yes. Take a look at the Layout Tables and Cells task pane.

Q: What about table layering, similar to that in Macromedia Dreamweaver?

A: Yes, we have new table layout tools and table cell decorations functionality in this release.

Q: What makes FrontPage 2003 better than Dreamwaver MX?

A: FrontPage is easier to use, provides better integration with Office and is the customization tool for SharePoint.

Q: Publishing to a 7,000 page website is scary in FrontPage 2002 so I use FTP. Will the Publishing feature of 2003 provide us greater control?

A: Yes. We now have the new Remote Web Site view in the Web Site tab and provide improved functionality such as filters and synchronization.

Q: Has Microsoft optimized the HTML Rendering engine to create cleaner code?

A: Yes. Our HTML preservation is top-notch, we've added a new Optimize HTML feature, and we've made the code even tighter.

Q: Will FrontPage 2003 comply to W3C standards instead of M$ Standards?

A: Yes FrontPage 2003 complies with W3C standards. Just take a look at the new accessibility and browser compatibility dialogs.

Q: Does FrontPage 2003 still add Metatags by defult to the coding?

A: Not by default any longer but you can add via the tools menu.

Q: Does FrontPage have support for CSS2 designs?

A: Yes it does
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NEW TECHNOLOGIES

Information Rights Management (IRM)

IRM functionality in Office Professional Edition 2003 can help protect sensitive internal business information, such as confidential planning documents or financial reports. You can set policies that wield greater control over who can open, copy, print, or forward information created in Microsoft Office Word 2003, Microsoft Office Excel 2003, Microsoft Office PowerPoint® 2003, and Microsoft Office Outlook® 2003.

IRM relies on Microsoft Windows® Rights Management Service (RMS) technology in Microsoft Windows Server™ 2003. 

Note  Office Professional Edition 2003 enables you to create IRM-protected content and grant access and editing permissions to other users for files or e-mail messages. Office Professional Edition 2003 also enables you to apply policy templates to new IRM-protected content you create. With Microsoft Office Standard Edition 2003, you can read and edit (if permitted) IRM-protected files and e-mail. 

Q. Can I send an IRM protected document to someone who does not have the latest version of Office?

A. You can share a protected file easily with someone who is not using Office Professional Edition 2003, such as a customer or a key business partner outside your company. For companies that do not use Office Professional Edition 2003, Microsoft provides a free IRM viewer, or Rights Management Add-on for Microsoft Internet Explorer, for reading protected files. The IRM viewer works only if the recipient has permission to read the file. Visit the Microsoft Windows site to download the Rights Management Add-on for Internet Explorer. The IRM viewer is free.

Q. What if I don’t have access to a Windows Rights Management Server?

A.  For home users and for organizations that do not host their own Windows RMS on Windows Server 2003, Microsoft has provided a limited time trail online service. Using Passport authentication with this service, such users can leverage key IRM features to help protect their sensitive information.
Q. Can IRM protect pure XML documents produced by Word? Or .doc only? 
A. Only binary document formats (.doc, .ppt, .xls) and messages. 

Q. How do you plan on dealing with the issues of opening a protected document with a third party application, perhaps bypassing the IRM? 
A. Since the content is encrypted, only applications that support RM can open the content....so far, that is only Office and the rights management add-on for IE (RMA) 

Q: Is it possible to revoke an individuals rights after a document is sent? If so, will this work with both the Passport based server and the Windows 2003 RMS module? 


             
A: Revocation is only supported when and organization owns the server. So, revocation will not work with our Passport-based free service. If an organizations buys Windows Server 2003 w/ Rights Management Services and you create content using server-based 

Q: When revocation is performed on a document, is it done only for a single document, or is it done for all documents that email address has permissions to? 

A: Revocation can be targeted at a single document. Keep in mind that revocation is a fairly large hammer to use for this. There are others means to better control license freshness like make licenses expire and cause users to go back and request a new 


Q: How does IRM work when a user is offline? Or does it work at all? 

A: In principal everything works offline, however, the first time you access IRM content, you will need to access the server to verify you are who you say you are. We did special work in Outlook to do that automatically in cache mode on sync. 


Q: How are permissions handled when an IRM document is attached to an IRM email? Will the doc inherrit the email permissions? 

A: When an IRM document is attached to a new IRM e-mail message, we will not modify the IRM permissions associated with the document. If the document did not have any IRM permissions associated with it, it will inherit the permissions associated with the e-mail message. 

Q: Will an organization's administrator be able to open secured documents say, in the interest of monitoring an employee? 

A: When a corporate RM server is used within an organization to help protect the organization's intellectual property, we believe that the corporation owns that IP and the RM server administrator will be able to configure the server such that the corporation can access this content. 

Q:  Can I synchronize protected email with my PDA and then open it or open a protected document on a notebook without being connected to the network? 

A: You can synchronize IRM messages with PDAs, but they will likely appear as a simple message, with some plain-text and an attachment. The act of synchronizing should not affect your ability to open the message on you notebook at a later date.

Q: When somebody sends a rights restricted e-mail and the authenticating server is Passport, would Passport admins be able to see the content when the recipient gets a certificate. 

A: Although this is technically feasible, it is not Microsoft's policy to decrypt content of this nature, unless required to do so by law. Additionally, the RM server is stateless and the content is never sent to the server. 

Q: Does Office 2003 prevent 3rd party screen capture programs from securing the contents displayed in an office application? 
A: No. We do not have platform level support on existing operating systems to block screen captures. And, even if we could, we can't stop all possible attacks. For example, even if we did block screen capture, we cannot stop people from taking digital camera pictures, for example. We do block Print Screen, but not third party screen captures. 

OTHER

Q: What’s new in Access?

A: Microsoft® Office Access 2003 is the database management program that gives you an improved user experience and an expanded ability to import, export, and work with XML data files. Working in Access 2003 is easier because common errors are identified and flagged for you with options to correct them. Additionally, a new feature to Access 2003 also helps database developers view information on dependencies between database objects.
Q: Has the number of maximum records been increased in Access?

A: There is no limit to the number records in Access 2003, nor was there in previous version of Access.  The only limitation is the size of the overall database which needs to be less than 2GB. This was also true with Access 2002.
Q: Is there anyway to create a SharePoint site for home users?

A:  No not at this time.
Q: Can you create a shared workspace with users who do not have access to a SharePoint Portal Server?

A:  The Groove Mobile Workspace for SharePoint Team Services, available today, allows a Groove Workspace user to create a synchronized copy of content stored on a SharePoint team site to use offline, and to extend that content outside the organization, without the need to deploy servers outside the company's firewall. Building on the success between Groove Workspace and SharePoint Team Services, the Groove Mobile Workspace for Windows SharePoint Services extends this integration functionality with support for Office 2003 and form libraries for Microsoft's new information gathering application, Microsoft Office InfoPath 2003. Any changes made to Office 2003 documents stored in a Groove Mobile Workspace for Windows SharePoint Services, including InfoPath libraries, are automatically synchronized with the SharePoint site when the user reconnects. For example, an auditor can download a copy of an InfoPath form stored on a SharePoint site into a Groove Mobile Workspace. She can fill out the form while disconnected at a client site, and save the changes back to Groove. When she reconnects to the network, Groove will automatically synchronize the InfoPath document on her desktop with the copy on the SharePoint site.  See Groove Networks website for more information www.groove.net

Q: What type of support is available with the Student and Teacher Edition?

A: Personal Support helps home users and home office customers with installation and basic usage issues. 

If you need help with advanced issues, such as development or deployments, visit the Professional Support Options page. 

The Personal Support options available to you are: 

Online Support: 
· Available 24-hours a day. Responses are normally sent back to customers within a 24 hour period.
· This Product Support currently* includes two incidents and unlimited installation support at no charge.
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	Options
	Price Per Incident

	  
	2 incidents and installation support
	No charge 

	 
	Paid support
	$35.00 U.S.


Phone Support: 
· With a support professional.

· This Product Support currently* includes two incidents and unlimited installation support at no charge
	Options
	Price Per Incident
	Phone Numbers

	2 incidents and installation support
	No charge 
	(425) 454-2030**

	Paid support
	$35.00 U.S.
	(800) 936-5700

	TTY/TDD
	Will vary depending on the service option
	(800) 892-5234 

	**Long distance charges may apply.

	


Q: Has the Academic Pricing dropped for Office?

A:  Qualified education users can receive special discounts on Microsoft software by purchasing Academic Edition Full-Packaged Product (FPP) from selected retail outlets. Below you will find a list of currently available products and estimated retail prices. 

If your institution needs five or more copies of Microsoft products, learn more about how you can get the lowest available prices through our Academic Volume Licensing programs. 

APPENDIX

Other Sources of Information

· For more information on Microsoft Office visit 
· www.microsoft.com/office
· Find Tools for Your Job

· www.office.microsoft.com/info/occupations 
· Build your skills at your PC with Microsoft eLearning Library

· http://www.microsoft.com/mspress/business/bizusers/default.asp
· Prepare for Office 2003 Editions with Microsoft Press Books

· http://www.microsoft.com/mspress/office/office2003/learning.asp
· Show what you know with the Microsoft Office Specialist Certification

· http://www.microsoft.com/traincert/mcp/officespecialist
More Q & A can be found via online chat transcripts with Microsoft Office Product Managers at 

http://www.microsoft.com/office/preview/chats.asp
Microsoft Office 2003 Reviewer’s Guides

Review in depth all new features.  Available at:

Publisher 2003
http://www.microsoft.com/office/preview/publisher/guide.asp
Office 2003 Editions
http://www.microsoft.com/office/preview/editions/guide.asp
FrontPage 2003 
http://www.microsoft.com/office/preview/frontpage/guide.asp
Outlook 2003 with Business Contact Manager  http://www.microsoft.com/office/preview/editions/contactmanager/overview.asp
Project 2003  
http://www.microsoft.com/office/preview/project/default.asp
Visio 2003
http://www.microsoft.com/office/preview/visio/default.asp
InfoPath 2003
http://www.microsoft.com/office/preview/infopath/default.asp
Topics for IT Professionals:

http://www.microsoft.com/technet  (all topics below can also be searched for by keyword at technet)

Office 2003 Resource Kit Tools (free download of beta version, code to be updated to final at launch)    http://www.microsoft.com/office/ork/xp/journ/orkbeta.htm  

What is it: for organizations to simplify deployment, provide increased control over security issues, and improve your ability to manage configuration and maintenance of the Microsoft® Office 2003 System. 

Office 2003 Security Whitepaper http://www.microsoft.com/technet/treeview/default.asp?url=/technet/prodtechnol/office/Office2003/Plan/O3secdet.asp
IRM Whitepaper

http://www.microsoft.com/technet/treeview/default.asp?url=/technet/prodtechnol/office/Office2003/Plan/Of03IRM.asp
Sharepoint Portal Server (numerous guides, topics on www.microsoft.com/technet)

http://www.microsoft.com/technet/treeview/default.asp?url=/technet/prodtechnol/office/Office2003/Plan/Of03IRM.asp
InfoPath
http://www.microsoft.com/office/preview/infopath/default.asp
Live Communications Server 2003 http://www.microsoft.com/office/preview/livecomm/default.asp
Live Meeting   Live Meeting
Microsoft Office System Launch live events begin October 21st.  Users can sign up for more information on local events near them at http://www.officesystemlaunch.com/entryForm.aspx
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